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CK-RX65N 
SIM activation, Creating the trial account and using Dashboard with RYZ014A 
or Ethernet Application for AWS - Getting Started Guide 
Introduction  
This document describes a system that uses the CK-RX65N Cloud Kit board from Renesas. This system 
incorporates the CK-RX65N running Amazon FreeRTOS and via Ethernet/Cellular connection. It visualizes 
HS3001, ZMOD4410, ZMOD4510, OB1203, ICP10101 and ICM20948 sensor information on Amazon Web 
Services (AWS) and controls LEDs on the board. 
 
There are two methods of connectivity for CK-RX65N. One is the Ethernet, second is the Cellular CAT M1 
using RYZ014A.This document shows both connectivity methods. 
 
In addition, this document describes the following: 
• How to activate the SIM card that is contained the CK-RX65N 
• How to create the 10 USD of free trial account for AWS 
• How to operate and install the information of certification for cloud 
• How to see and run the sensor data on the dashboard 
 

 

Figure 1.   CK-RX65N (with RYZ014A Pmod) 
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1. Terms 
Terms used in this document are explained below.  
 
Table 1.   Terms 

Term  Meaning  

AWS  AWS Amazon Web Service  

 
2. Preparation 
2.1 Hardware Configuration 
The hardware configuration of the demo project is listed in the table below.  

Item Content Description 

CK-RX65N Cloud Kit  Target board for  
CK-RX65N  

Please see detail 
https://www.renesas.com/rx/ck-
rx65n 

RYZ014A Cellular Pmod module  SIM card This Pmod is contained with CK-
RX65N of kit with SIM card 

PC  Windows® 10  
Google chrome 

Recommended OS.  
Web browser used.  
 

 

2.2 Software Configuration 
The software configuration of the demo project is listed in the table below.  

Item Content Version 

Integrated development 
environment  

e2 studio  2022-01  

Complier CC-RX 
GCC (Planning) 

V3.03  
- 

Communication Software Tera term Version 4.106 
Emulator  E2 emulator Lite (on-board)  - 
RTOS AWS FreeRTOS V202107.00 

 

2.3 Tera term Setting 
Item Settings 

Baud rate 115200 
Data length 8 
Parity none 
Stop bits 1 
Flow Control none 

 

https://www.renesas.com/rx/ck-rx65n
https://www.renesas.com/rx/ck-rx65n
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3. System Diagram 

 

Figure 2.   System Diagram 

4. Connection to AWS 
AWS account is necessary to connect CK-RX65N Cloud Kit to AWS.  

Note:  Renesas provides the 10 USD of AWS account credit to users who buy the CK-RX65N and this 10 
USD credit cannot be used for an existing account.  

This document covers two ways of connecting to the AWS account: 

• Case 1: For users who want to use trial AWS account with 10 USD credits and Renesas Dashboard,  
please refer to section 4.2 For Users Using the Provided Dashboard and Kit AWS Account  to get 
this AWS account. 

• Case 2: For users who already have an AWS account and want to use it instead of trial account, please 
skip section 4.2 For Users Using the Provided Dashboard and Kit AWS Account  and refer to 
section 4.5 For Users Using their Own AWS Account to use account with application. 

 
4.1 Common Users: To Import the Project, Activate SIM Card 
4.1.1 Importing the Project 
Use the following steps to prepare the software for the demo program:  
1. Extract the project files from the archive and copy them to the C drive.  

Please unzip it the project file to the short path of your PC. 
If the path is deep, a build error may occur due to the file path length issue. 

2. Launch e2 studio and specify a workspace directory and click Launch. 

 

Figure 3.   Launch e2 studio 
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3. Select File > Import….  
 

 

Figure 4.   Select Import 

4. Click General > Existing Projects into Workspace > Next. 

 

Figure 5.   Select Existing Projects into Workspace 
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5. Click Browse…, then specify the root directory as described later in this section.  
 

 

Figure 6.   Find the Project 
You can choose two types of connectivity and compiler when importing the project. 
Please go to “[Project Root folder]\projects\renesas\” folder. 
 
Table 2. Details of Each Project 

Project Name Compiler Connectivity 
rx65n-new-ck in the “source-rx-eth” zip CC-RX Ether 
rx65n-new-ck-cellular in the “source-rx-cell” zip Cellular 
rx65n-new-ck-gcc (Planning) GCC Ether 
rx65n-new-ck-cellular-gcc (Planning) Cellular 

 

 

Figure 7.   Project Files 

This example uses “rx65n-new-ck-cellular” as the cellular project. 
Open the “ [Project Root folder]\projects\renesas\rx65n-new-ck-
cellular\e2studio\aws_demos” folder. 
If you use another project, please open “\aws_demos” folder of your selected project. 
 

 

Figure 8.   Select the Project Folder 



CK-RX65N SIM activation, Creating the trial account and using Dashboard with RYZ014A or Ethernet 
Application for AWS - Getting Started Guide 

R01QS0064EJ0131  Rev.1.31  Page 7 of 43 
Jan.19.24  

Finally, click Finish.  
Note: Make sure that the Copy projects into workspace option is unchecked. 

 

Figure 9.   Finish Importing the Project 

6. Check and set the SIM card information. 
Double click the “aws_demos.scfg” to open the smart configurator. 

 

Figure 10.   Open the Smart Configurator 
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Table 3. Information for Setting SIM of Cellular Driver When Using Truphone SIM Card in the Kit 

Items Truphone  

APN (Access point name) iot.truphone.com 
UserID (Access point login ID) (Null) 
Password (Access point password) (Null) 
SIM card PIN code (Null) 
Authentication protocol type 1 (PAP) 

 
Note: Please use the configuration of the included SIM card. 

Set the above configuration values when using the SIM contained the kits. 

If you are using a different SIM card, please set the value provided by the SIM provider. 

 

Figure 11.   Set the SIM Information when Using Contained SIM Card in the Kit 

7. Execute code generation. 
If you have changed the Smart Configurator settings, click Generate Code. 

 

 

Figure 12.   Generate Code 

8. Apply patch files. 
This project must be patched after code generation. When running code generation, the source code will 
be overwritten by code generator. For this reason, please apply the patch each time after running code 
generation. 
Refer to “[Project Root folder]\readme-path-memo.txt” for how to apply the patch. 
The patch sources are located in “[Project Root folder]\sorce_patch” folder. 
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Figure 13.   readme-path-memo.txt and sorce_patch folder 

9. Select Project > Build All and confirm that 0 errors are reported.  
 

Note:  Make sure to clean the project before building it for the first time. If a demo build error occurs 
after the initial build, clean the project again and then rebuild it.  

 

Figure 14.   Build the Project 
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10. Debug Configuration  

 

Figure 15.   Configuration Debugger 1/2 

  

Figure 16.   Configuration Debugger 2/2 
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4.1.2 Data Publishing Interval Settings (Optional) 
Data publish interval can be set by the user. Default publish interval time is 10 seconds. 
“mqtt_demo_mutual_auth.c” file has the macro to change the publish time interval. 

#define DATA_PUBLISH_INTERVAL_IN_SEC 10U 

 

Figure 17.   Data Publishing Interval Settings (Optional) 
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4.1.3 Running the Application Project 
To run the Application project, use the instructions in the following section to set up the board. 

4.1.3.1 Connecting the Board to the Serial Port Console of the PC  
1. On the host PC, open Windows Device Manager. Expand Ports (COM & LPT), locate USB Serial 

Device (COMxx) and note down the COM port number for reference in the next step. 
 

Note:  USB Serial Device drivers are required to communicate between the CK-RX65N board and the  

 

Figure 18.   USB Serial Device in Windows Device Manager 

2. Open Tera Term select New connection and select Serial and COMxx: USB Serial Device (COMxx) 
and click OK. 

 

Figure 19.   Selecting the Serial Port on Tera Term 
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3. Using the Setup menu, select Setup > Terminal… and select “AUTO” as Receive and check the Local 
echo box, as shown below. 

 

Figure 20.   Select Receive: “Auto” and Enable “Local echo” on the Terminal Setting 

4. Using the Setup menu pull-down, select Serial port… and ensure that the speed is set to 115200, as 
shown below. 

 

Figure 21.   Select 115200 on the Speed Pulldown 
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5. Complete the connection. The Configuration CLI Menu will be displayed on the console as shown below. 

  

Figure 22.  Main Menu 

6. In the CLI shown in the above screenshot, choose the number to select the commands. For example, 
when you press ‘1’ the firmware version of the application is displayed as shown below. To return to the 
main menu press “space bar” key. 

  

Figure 23.   Get Version Information 

4.1.4 Running the Application and Activation of SIM Card Included in CK-RX65N 
This section explains how to activate the SIM card that is contained in CK-RX65N. If you use ethernet, you 
can skip this step. 

1. Press ‘4’ to display CAT-M Information (IMEI &ICCID). This menu will communicate with the CAT-M 
module to obtain the IMEI and ICCID values needed for activating the SIM card. Upon success, the IMEI 
and ICCID values will be displayed on the terminal screen. The program will continue to attempt to 
communicate with the CAT-M module until it has successfully connected or timed out. The IMEI and 
ICCID values are used to activate the SIM card.  

  

Figure 24.   CAT-M Information 
Note: Activation instructions are provided in section 4.1.5 that follows. 
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4.1.5 Activating SIM Card 
A Truphone or MicroAI SIM card is included in this kit.  

Note: The MicroAI SIM card discontinued support of CK-RX65N. If a MicroAI SIM card was included in the 
kit, please contact Renesas support to request a replacement to a Truphone SIM card. To identify a 
MicroAI SIM card, it is the card where the manufacturer's name is not printed on the SIM card. 

 

Please activate the SIM card using the following steps: 

To activate the included Truphone SIM card, please visit the Truphone SIM Activation platform at 
truphone.com/connectit and use the following steps: 

1. On the Business page, click Start activation button under IoT SIM Activation. 

 

Figure 25.   Activating the SIM Card on Truphone 

2. Create a new Truphone Account by selecting Sign up (next to Don’t have an account yet?) and fill-in 
your full name, Email, and a password. Then click Sign up to create a new account. 

 

Figure 26.   Signing In 

https://en-support.renesas.com/dashboard
https://truphone.com/connectit
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3. Select Personal as the account type and press Get Started. 

 

Figure 27.   Selecting the Account Type 

4. Verify your email by entering the activation code sent to your email account. 

 

Figure 28.   Verifying the Email 
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5. Complete the Profile information form – then select Create account.  

 

Figure 29.   Completing the Profile Information 

6. Select Activate SIMs to activate your individual SIM by ICCID. 

 

Figure 30.   Activating SIM 

7. Enter the ICCID value. 

 

Figure 31.   Entering the ICCID 

8. You will receive email confirmation when the SIM card activation is complete.  
 The CK-RX65N kit and SIM card should be activated and can be validated on the Tera Term terminal. 
 

Note: The SIM card includes free credit for the first 90 days / 50 MB. After the free data charge is used 
up, communication charges will be incurred. 

Disclaimer 
The activation steps above are provided by the SIM provider, Truphone. They are the most current at the 
time of publishing this application note. If you need help activating your SIM card, contact Truphone support 
iot.truphone.com or Contact Support | Truphone. 
If you have a SIM card from any other provider then contact the technical support for that provider.  
For any other issue that cannot be resolved please contact Renesas Support at Technical Support. 

https://iot.truphone.com/
https://www.truphone.com/support/contact-support/
https://www.renesas.com/us/en/products/microcontrollers-microprocessors/rx-32-bit-performance-efficiency-mcus/support
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Note:  The SIM card provider for the Quick Start Guide example project is Truphone. If you use any other 
SIM card provider, you must change the Access Point Name required for the SIM card provider in 
your global region. Failure to do so could result in the RYZ014A not connecting to the cellular 
network. 

 

4.2 For Users Using the Provided Dashboard and Kit AWS Account  
This section explains account registration, accessing the dashboard, and getting the board “UUID” 
information. 

4.2.1 Getting the Board UUID Information  
1. Press ‘3’ from the Main Menu to display board UUID. This displays the board UUID information on the 

console as shown in the screenshot below. You will need this information to register on the Cloud 
Dashboard. 

 

Figure 32.   Getting Board UUID Information 

4.2.2 Getting the Account 10 USD for Trial of AWS 
1. Register/sign up at “https://renesas.cloud-ra-rx.com/” with an email account that was not used 

previously for signing up to an AWS account.  
Note: The provided free credit starts being used when users register their email and UUID on this 

system. Renesas recommends disabling the AWS EC2 service when users do not use this 
system. 

 Please refer to section 6.8, How to Enable/Disable EC2 Instance. 

 

Figure 33.   Get the Account 10 USD for Trial of AWS (1/2) 

https://renesas.cloud-ra-rx.com/
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Figure 34.   Get the Account 10 USD of Trial of AWS (2/2) 

2. Wait for AWS verification email (it may take up to 10 min). Then, enter the email and UUID to register the 
kit as shown in the following window. You can get the UUID from section 4.2.1 Getting the Board UUID 
Information  

 Note: Only 1 device will be assigned to an account. 

 
Figure 35.   Register Device 

3. Verify the AWS account in your email that you registered. 
4. Wait for the status change on the registration page or wait for provisioning to complete. Please refresh 

the page in case the “Registration in progress” screen still shows up. 

 

Figure 36.   Dashboard Build In Progress 
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5. Once the account status shows up as active in the registration page, click on the device to see device 
UUID. 

 
Figure 37.   Active Device 

6. After finishing the progress, you can get the connection certificate using the “Download Certificate” 
button. This is used for installation on the application demo of kits that you got in the previous step. 

 

Figure 38.   Dashboard Build Complete 

7. Click “Go To Dashboard” to access the dashboard. First time users will access the dashboard with 
credentials “admin” for both username and password and will be directed to change the password. 
Once completed, users can access the dashboard. 

 

Figure 39.   Dashboard for this Application 
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4.3 Hardware Preparation 
• Connect micro-USB cables to debug port (J14 on the CK-RX65N board) 
• Connect micro-USB cables to serial port (J20 on the CK-RX65N board) 
• Connect the RYZ014A Cellular Pmod module to the Pmod1 
• Set the Jumper of J16 “Debug” 
• Connect RYZ014A Cellular Pmod module and insert SIM card. 
 

 

Figure 40.   Connecting the USB and RYZ014A Pmod 

4.4 Software Preparation - Running Project from IDE 
4.4.1 Storing the Device Certificate, Key, MQTT Broker Endpoint and IoT Thing Name 
Device Certificate, Device Private Key, MQTT Broker Endpoint and IOT Thing name need to be stored in the 
data flash for the application to work. These are obtained after registering to the Cloud Dashboard.  

1. Press ‘2’ on the Main Menu to display Data Flash related commands as shown in the following 
screenshot. This sub menu has commands to store, read, and validate the data.  

 

Figure 41.   Data Flash related Menu and Commands 
2. Unzip the cert.zip from the dashboard. 
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3. To store the Device Certificate, press the option ‘b’ and Click the File tab of the Tera Term and Send 
File option and choose the downloaded Device certificate file from the dashboard 
“xxxxxcertificate.pem.crt”. The details for downloading the certificates are provided in the 
Dashboard document linked as part of this Application Note. 
 

 

Figure 42.   Accessing the Device Certificate 

 

Figure 43.   Downloading the Device Certificate into the Data Flash 
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Figure 44.   Status of the Downloaded Device Certificate into the Data Flash 

4. To store the Device Private Key, press the option ‘c’ and Click the File tab in the Tera Term and Send 
File option and choose the downloaded Device Private Key “xxxxxxxprivate.pem.key” which is 
downloaded from the Dashboard download link. 

5. Open the “iot-data.json” file. 
This file has information about IoT things name and IoT endpoint. 

 

Figure 45.   Getting the IoT Things Name and IoT Endpoint Information 
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6. To store the MQTT Broker end point, copy the end point string between the quotes xxxxxxxxxx.iot.us-
east-1.amazonaws.com from the downloaded certificate link, press the option ‘d’ and click the Edit tab 
in the Tera Term and “Paste<CR>” and verify and confirm the valid string and press OK. 
Note: Please copy the IOTEndpoint without “”.  

 

Figure 46.   Copy the IOTEndpoint 

 

Figure 47.   Storing the MQTT IoT endpoint into the Data Flash 

7. To store the IOT Thing Name, copy the Thing Name string between the quotes xxxxxxxx-xxxx-
xxxxxxxx-xxxx of IoT thing Name from the downloaded certificate link, press the option ‘e’, click the 
Edit tab in the Tera Term and “Paste<CR>”, verify and confirm the valid string, and press OK. 
Note: Please copy the IOTthingName without “”. 

 

Figure 48 Copy the IOTThingName 

 

Figure 49.  Storing the Thing Name into the Data Flash 
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8. Press option ‘f’ and ‘g’ to read and validate the stored information in the data flash.  
 

Note:  Validation of the stored data is very limited and validates minimum set of data points. Users are 
required to input the valid data to the flash obtained from the dashboard for the proper working of the 
application. 

4.4.1.1 Starting the Application 
After activating the SIM card, registering to the Dashboard and configuring the required Cloud credentials via 
the CLI, the application is ready to run. Press option ‘6’ to start the application. The application prints a 
welcome screen along with the status of validating the Cloud credentials data present in the data flash as 
shown below.  

When the connection is successful, the data is shown. 

 

 

 

Figure 50.   Welcome Screen on the Console  
Note: Sensor data can be read correctly after the stabilization time. 
For details on the stabilization time, please see “Table 4. Sensor Stabilization Time”. 
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4.5 For Users Using their Own AWS Account 
Note: Complete the steps up to “Check AWS IoT endpoints.”  
 
Get an AWS Account 
Get an AWS account > Click the "Sign into the Console" button. 

When considering using AWS, you can use the AWS free tier AWS Free Tier. 

Log in to the AWS Management Console 
 Amazon Web Services > My Account > AWS Management Console 

 

Figure 51.   Login the AWS 
Move to IoT Core Control Panel 
• AWS services > All services > IoT Core 

 

Figure 52.   Search the IoT Core 1/2 

https://aws.amazon.com/?nc1=h_ls
https://aws.amazon.com/free/?nc1=h_ls&all-free-tier.sort-by=item.additionalFields.SortRank&all-free-tier.sort-order=asc
https://aws.amazon.com/?nc1=h_ls
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Figure 53.   Search the IoT Core 2/2 
 Create a Security Policy 
• Secure > Policies > Create a policy 

 

Figure 54.   Create the Policy 1/3 

 

Figure 55.   Create the Policy 2/3 



CK-RX65N SIM activation, Creating the trial account and using Dashboard with RYZ014A or Ethernet 
Application for AWS - Getting Started Guide 

R01QS0064EJ0131  Rev.1.31  Page 28 of 43 
Jan.19.24  

Copy the following code  

{ 
 "Version": "2012-10-17", 
 "Statement": 
 [ 
  { 
   "Effect": "Allow", 
   "Action": "iot:Connect", 
   "Resource": "*" 
  }, 
  { 
   "Effect": "Allow", 
   "Action": "iot:Publish", 
   "Resource": "*" 
  }, 
  { 
   "Effect": "Allow", 
   "Action": "iot:Subscribe", 
   "Resource": "*" 
  }, 
  { 
   "Effect": "Allow", 
   "Action": "iot:Receive", 
   "Resource": "*" 
  } 
 ] 
}  

Paste the copied code into the policy syntax > Create 
 

 

Figure 56.   Create the Policy 3/3 
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Register your device (thing) with AWS IoT 
• Manage > Things > Register a Thing 

 

Figure 57.   Creating the Things 1/5 

Creating AWS IoT things > Create a single thing 

 

Figure 58.   Creating the Things 2/5 
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• Add your device to the thing name > Next 
• Make a note of the name with a text editor (this will be used later) 

 

Figure 59.   Creating the Things 3/5 
• Auto-generate a new certificate. 

 

Figure 60.   Creating the Things 4/5 



CK-RX65N SIM activation, Creating the trial account and using Dashboard with RYZ014A or Ethernet 
Application for AWS - Getting Started Guide 

R01QS0064EJ0131  Rev.1.31  Page 31 of 43 
Jan.19.24  

• Add a policy for your thing. 

 

Figure 61.   Creating the Things 5/5 
Download a certificate for this thing/A public key/A private key 

 

Figure 62.   Download a Certificate for this Thing/ Public Key/ Private Key 
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Check AWS IoT Endpoint 
• Make a note of the endpoint in a text editor (this will be used later) 

 

Figure 63.   Check AWS IoT Endpoints 

You can also access the tutorial to register a device to AWS IoT tutorial on GitHub at 
https://github.com/renesas/amazon-freertos/wiki/Register-device-to-AWS-IoT 

4.5.1 Installing the Credentials 
Please see section 4.4 Software Preparation - Running Project from IDE for details. 

4.6 Connecting to AWS IoT 
This section describes the steps to be followed to connect the device to the AWS IoT. 

Note: For Ethernet applications, firewalls in the network may prevent connectivity to AWS IoT. Configure the 
network to allow access to the MQTT Port 8883. 

https://github.com/renesas/amazon-freertos/wiki/Register-device-to-AWS-IoT
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4.7 Verifying the Application Project using AWS Dashboard and Renesas 
Dashboard 

This section describes the steps on how to verify this application example’s functions.  

Note:  Wait for the board to get the IP address from the service provider upon successful cellular 
initialization, and the board to resolve the DNS lookup for the endpoint. After the successful MQTT 
connection message on the Console “Successful MQTT Connection to the end point”, the device 
is ready for Publishing and Subscription of Messages. 

Note: This Application involves AWS MQTT IOT Core, user has an option to use the AWS IOT Dashboard 
for the Validation purpose, in addition to using the Renesas GUI based Dashboard for customized 
view of all the Sensor Data. 

 

For verification purposes, the user can use the AWS IoT core Dashboard for configuring and controlling the 
subscription and publishing of the topics as described in the following sections. 

On the AWS cloud Dashboard, go to IoT Core and select Test, then choose MQTT test client. Subscribe to 
a topic listed below one at a time. The sample snapshot for subscribing to the topics are shown below. 

Note:  The messages shown below are case sensitive; users need to take care of this while entering the 
publish or subscribe messages. 
Only enter one message at a time. Copy the message ‘as-is’ between the quotes and do not include 
any extra spaces. 

    "aws/topic/iaq_sensor_data" 
    "aws/topic/oaq_sensor_data" 
    "aws/topic/hs3001_sensor_data" 
    "aws/topic/icm_sensor_data" 
    "aws/topic/icp_sensor_data" 
    "aws/topic/ob1203_sensor_data" 
 
Note: After the subscription to the Topics, the Dashboard is ready to receive the messages being published 

from the device. 

 

Figure 64.   Subscribe to a Topic Messages on the AWS IoT Screen 
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Figure 65.   Subscribed Messages on the AWS IoT Screen 

4.8 LED Alerts 
The board is subscribed to the topic below: 
ck_rx65n_test/example/topicRx  
 
If we publish the below data from AWS console  
HS3001 temperature alerts:  
Based on the temperature, the dashboard sends alert messages to CK-RX65N kit via the following topic: 
 
Topic:   aws/topic/set_temperature_led_data    
 
Message: {"Temperature_LED":"HOT"}               Will turn on RED in Tri-Color LED 
Message: {"Temperature_LED":"WARM"}           Will turn on GREEN in Tri-Color LED 
Message: {"Temperature_LED":"COLD"}             Will turn on BLUE in Tri-Color LED 
  
Example: 
Click Test > MQTT test client 
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Figure 66.   Publish the MQTT Message 1/2 
OB1203 SPO2 alert alerts:  
 
Based on the SP02 value, dashboard sends the alert messages to the CK-RX65N kit via the following topic: 
 
Topic:   aws/topic/set_spo2_led_data 
 
Message: {"Spo2_LED":"ON"} Will turn on BLUE LED in CK-RX65N 
Message: {"Spo2_LED":"OFF"} Will turn off BLUE LED in CK-RX65N 
 

 

Figure 67.   Publish the MQTT message 2/2 

5. Restrictions 
5.1 Communication Time (Cellular Version of Project) 
This version of the cellular project may disconnect when running for more than 10 hours. 

Then it shows the following errors at the terminal. 

It can re-communicate when you reset the device. 

If you face this issue least a few hours, please do “8. Apply Patch files” step 4.1.1 section. 
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5.2 Automatic Alert Feature from Renesas Dashboard  
This application does not support automatic alerts from Renesas Dashboard via LED status on the board at 
this time. 

6. Note and Troubleshooting 
6.1 Sensor Stabilization Time  
Each sensor has a stabilization time during which correct values cannot be read. 

The following table shows the details of sensor stabilization times.  

Table 4. Sensor Stabilization Time 

Sensor Name When power up first time After soft or hard reset 

ZMOD4410 IAQ Up to 1 min Up to 1 min 

ZMOD4510 OAQ Up to 1.5 hours Up to 1 hours 

OB1203 Up to 20 Min  

(After putting finger on sensor, it 
may take up to 60 seconds to 
sense data) 

Up to 20 seconds 

(After putting finger on sensor, it 
may take up to 60 seconds to 
sense data) 

HS3001 Up to 30 seconds Up to 10 seconds 

ICP Up to 30 seconds Up to 10 seconds 

ICM Up to 30 seconds Up to 10 seconds 

 

6.2 Connection Issue When Using Ethernet (Wired cable) 
The Ether PYH only supports the full-duplex communication. If your router or Ethernet hub only supports half 
duplex, it cannot connect to the internet. Please use full duplex devices. 

6.3 Current Supply Short Issue When Using RYZ014A 
If the CK-RX65N board is not powered through the Debug port (J14), the current available to the board may 
be limited to 100 mA. When using the supplied RYZ014A Pmod module with other code (found here: 
RYZ014A - LTE Cat-M1 Cellular IoT Module | Renesas) be aware that this Pmod has a maximum operating 
current of 480 mA dependent upon the LTE band, Tx/Rx settings, and network coverage. Please ensure that 
the host board can supply sufficient power or provide supplemental USB power via CN4 on the Pmod to 
avoid RF instability. 

https://www.renesas.com/us/en/products/interface-connectivity/wireless-communications/cellular-iot-modules/ryz014a-lte-cat-m1-cellular-iot-module?
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6.4 When Build Errors Occur 
If a 'No such file or directory' error occurs, the project path may be too long. When the path is longer than 
256 characters, e2 studio outputs errors at build time. 
When this error occurs, move the project to a shorter path location (such as, under C:\). 
 

6.5 When Unable to Log in to the Dashboard (Grafana Account) 
If you cannot log in to the Dashboard with the password you changed in step 6 of section 4.2.2 Getting the 
Account 10 USD for Trial of AWS, try the following: 

• Set “admin” in the Email or username field and set the changed password in the password field. 
 

When changing the password for the initial session, the username is not changed from admin. Therefore, 
admin must be entered in the username field. To enable users to log in with your own username and email 
address, please change the user information in the Server Admin menu after logging in. 

6.6 Notes on Performing Firmware Update Over-The-Air on AWS FreeRTOS 
The following symptoms occur when performing Firmware Update Over-The-Air (FOTA) on AWS FreeRTOS.  

1. Device (thing) names and credential information are overwritten.  
2. Processing of OTA fails after recovering from low power consumption mode. 
For more information, refer to the Tool News at: 

[Notes] RX Family Notes on Performing Firmware Update Over-The-Air on AWS FreeRTOS (renesas.com) 

6.7 When the Trial 10 USD is Used Up 
When the trial 10 USD is used up, status will change to “Quarantined”. At this time, the user cannot 
download the certificate or go to Dashboard. 

 
Figure 68.   Account Used Up Trial 10 USD 

Note: Please add payment options before the account is quarantined and enable the option on the 
dashboard. If the account is quarantined, please contact Renesas Customer Support. 

To enable option on the dashboard, go to the user profile. 

 

Figure 69.   Choose Profile 

https://www.renesas.com/document/tnn/notes-rx-family-notes-performing-firmware-update-over-air-aws-freertos
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Choose “Yes” for the Payment Preference Update Confirmation.  

 

Figure 70.   Payment Confirmation 
To add a credit card to continue using this account or using another AWS account, go to https://cloud-ra-
rx.awsapps.com/start#/, sign up with AWS account. 

 
Figure 71.   Sign up to AWS Account 

Go to Manage Console > Account > AWS Billing > Payment preferences > Add payment method. 

 

Figure 72.   Add Credit Card for Trial Account (1/4) 

https://cloud-ra-rx.awsapps.com/start#/
https://cloud-ra-rx.awsapps.com/start#/
https://us-east-1.console.aws.amazon.com/billing/home?region=us-east-1#/
https://us-east-1.console.aws.amazon.com/billing/home?region=us-east-1#/paymentpreferences
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Figure 73.   Add Credit Card for Trial Account (2/4) 

 

Figure 74.   Add Credit Card for Trial Account (3/4) 
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Figure 75.   Add Credit Card for Trial Account (4/4) 

6.8 How to Enable/Disable EC2 Instance 
AWS trial accounts start billing immediately after device registration. The following steps will disable the EC2 
instance, saving the user’s credits. 

Access AWS account from https://cloud-ra-rx.awsapps.com/start#/ using the dashboard credentials. (Refer 
to the Figure 71 to login). 

Note: If you wish to use the dashboard again, please enable the EC2 instance before using it. 
 

To disable the EC2 instance, use the following steps: 

1. From the Services menu, select Compute and then choose EC2. 

 

Figure 76.   EC2 AWS Service 

https://cloud-ra-rx.awsapps.com/start#/
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2. Choose the instance, then change the Instance state to Stop instance 

 

Figure 77.   Disable Instance  
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Website and Support 
Visit the following vanity URLs to learn about key elements of the RX family, download components and 
related documentation, and get support.  

CK-RX65N Kit Information 
RX&RA Cloud Solutions 
RX Cloud solution web 
RX Product Information  

renesas.com/rx/ck-rx65n 
renesas.com/cloudsolutions  
renesas.com/rx-cloud 
renesas.com/rx  

RX Product Support Forum  renesas.com/rx/forum  
RX Driver Package renesas.com/RDP 
Renesas Support  renesas.com/support 

 

http://www.renesas.com/rx/ck-rx65n
http://www.renesas.com/cloudsolutions
https://www.renesas.com/rx-cloud
http://www.renesas.com/rx
https://www.renesas.com/rx/forum
http://www.renesas.com/RDP
https://www.renesas.com/support
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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